Working with InRoads Survey

General InRoads Survey Orientation
Key Functionality Overview

Collecting Data

Coding Field Data

Loading Data Collector files

Displaying the Survey Data

Digital Terrain Models

Geometry Data

InRoads Survey - Purpose

Breakdown & process field collected data

Create CAD base file 'ﬂ]’

Build a Surface Model
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Data Collector Files

Survey supports downloading of data from

many electronic data collectors
SDMS (.cal)
Sokkia SDR (*.sdr)
Trimble DC (*.dc)
SMI'Raw: (*.raw)
LISCAD GSI Format (*.gsi)
Wild GRE (*.gre)
AASHTO SDMS (*.sdm)
Zeiss REC500 (*.zss)
Geodimeter (Topegraphy) (*.raw)
Niken (*.mwd)
JepCon FC4 (*ic4)

© 2011 Zen Engineering|

Loading Data Collector Files

T MotePad+ - [MEHEULA] =] E3

=11

The field data files lelalalal sl 2] =] mlet

W
th at I n Roads S u rvey M0, &D1,UH0,5FL. 0000000 ,ECO,E00. 0

§P,PHL,N 5000.0000,E 5000.0000,EL0.0000,--

SP,PHLL,N l00000.0000,E 100000.0000,ELA9S. 1100, --

reads m uSt be AS I I oc,0P11,H 100000, 0000, 100000.0000,ELESS. 110, -
EK,0P11,EP11,E3180.0000,EC0. 0000

EK,0P11,EP11,E3180.0000,EC0. 0000
L%, HIO.000,HROD, 000

53,0P11,FPL0,AZ356. 00000, ZE90. 00000, 5D514, 760, --
NotePad+ - [SACATON 4 ‘ ’ : 4 4
T{HoleRad Sl 1 EK,0PL1,BPL0,B5356. 0000, 00, 0000

Eile Edit Options MWindow Help BK,0FL1,BFL10,E3356.0000,EC0. 0000

][ = 0 5 = N O s v

20278.807 10z78.783 87.24% 101
20349.899 10364.376 96.458 200
Z0336.471 10377.496 S6.744 419 C/L STRIPE
20272.628 10301. 166 97.447 419 C/L STRIPE
20284.056 10284.676 97.169 300 PAVEMENT EDGE

20219.818 10206. 686 97.833 300 PAVEMENT EDGE
20198.191 10z11.487 96.251 419 C/L STRIPE
20133.598 10132.341 98.983 419 C/L STRIPE
20150.852 10122. 886 98.733 300 PAVEMENT EDGE
20079.810 10036. 666 99,44z 300 PAVEMENT EDGE
20082.759 10047.018 99.765 419 C/L STRIPE

Unchanged INS  Line 1. Column 1
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Importing Data

The Impor =

command

allows the

selection of

the file to be

loaded S — —
tneatris — |COT SR, oo |

rgior ) Zeiss RECS00}"255]
nguiar Units: | Geodimeter (T opographyIlraw) Dl

Geodimeter (Cross Sections)[* raw)

Topeon FCA( 4] Help
Hikan(*.mwd)

TDS[mi3)

File name; |
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The In-Survey Fieldbook

T h e F i e | d b O O k ieldbook Data - Main nment Project
lists the data e

[[Station Mame | Nonthing | Easting | Elevation | Code | Status T Backsight Paint | Backsihi 2] #|
5 7

[ 56 37406115 709264 39 6R27218 CP N 1727305 =
I I por e ro I I 374504.11...709262.22. 6458240 CP 18075923

the field info e

Observaions

St ti & i Noithin E asting Elevation | Code  Status | Horizontal Obs. | Vertical Obs. _Slope Dis~ ﬂ
ation e

7 947 540.7700

375057.61... 706346.06...534,3385. 104§ 827" 1340 1385500

37507305 70633609 5341525 104 82938 g0™1840" 1781850

g 37509344 70632035 5337570 104 P 2057 90°3043" 1525500

O b S e rvatl O n 375095 65..706316.32.. 5937928 104 101434 4T 1485650
375094.71..706312.23 5338971 104 P 1174740" 0728132 147.3400

37508694 _70630210..5343078 104 P 16°3815" 901839" 1437150

375080.30..706237.72. 534 6545 104 19°0823" {02y 154100

d ata C a n b e 375073.07..706296.54..534.8890 104 2072937 o457 160.4200
375066.42..706298.82..535.0299 104 P. 203332 Ergnial 167.4400
37505397 708307 08 5352541 104 192923" B3"R728" 182.0300

- 375046.15..706313.49..535.3096 104 P. 18°3344" BI"RE'IE" 191 E?Si‘_l
viewed and ' '
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Correction ‘Phase 1’

The Fieldbook is ‘Cleaned Up’ in two distinct
phases:

Plan View — Planimetric ‘visual’ line work and
graphics ... the Drafting / Drawing

3D — Elevational corrections via the DTM
The Plan View clean-up is first...
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Correcting Code Errors

The values for any shot can be edited to allow
for necessary changes or additions

% Edit Observation

Point Name: \<I< F94 5| s1| Motes:

Type: Computed 'I
Horigontal Observation: 2094 753"
Yertical Observaton:  [g7-22 2

Slope Distance: 238.7450 Adtributes:

Lode: 501 Code | Wame

Target Height 17.1900 & ?::B
Nothing: 3754572303 Drip
+

Easting 70ET34.0711
Elevation: 533.7751

© 2011 Zen Engineering
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eldbook Data - Zen Fieldbook 1

Eﬂﬂﬂﬂ ™ Duplicates Only |—;[

Stations:

Fieldbook Edits

| Elevation | Code | Status

[ StationMame | Morthing | Easting
1

FN
37622333 7OB24036 5345000 322 FM

B

Chanage: ¢ <|[104 -l el

Observations:

Poin Name_| Northing | Easting | Elevation | Code Stalus | Hotzortal Obs, | Vartical Obs. | Sios] 4|
04 PC : 15

37609565
376054.71
376086.594.
375080.30
375073.07.
375066.42
3750853.97.
37504615,
375041.50.
375040.56.
375042.74,
37505213,
375054 67
376067 42
376057 45
37607289
37609313
376095.09
375094.28

TOEIE.32.
TOEI2.23,
TFOE302.10,
TOE297.72.
TOE296.54.
T0R298.82.
TORI07.08,
T06313.49,
T06319.72,
T06326.00,
T0E332.97,
T06345.78,
70634666,
TOR346.15,
TOE345.78,
TOE335.84.
TOE320.00,
TOEIE.24.
TFOEIZ58,

G323 7926
£33 8971
5343078
534 6545
534.6890
5350293
535 2541
535.3096
5353489
5353411
5351485
5344786
5343616
£34. 3254
634 7160
F34 6068
634 2128
5343102
534 4117

Add Before...
Add After,
Edit

Delete

Cut
Copy

Find.

Center

Highiight Dbservations

Edit Siyle:

v B O bsenation

Right Face Angle
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90°3043"
an°2832
b
ki
a0°0457"
00151
BI°E728"
89756'36"
8a75E02"
89756 4"
89°5931"
a01058"
1244
90°1353"
0°0704"
0°1151"
a0°2026"
amEn”
anme2e"

Any changes
are made in
the In-Survey
Fieldbook

The original
field collection
file is not
changed

Graphical data

CAD is just a viewing mechanism for Survey.

o
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In-Survey and CAD

Starting InRoads Survey will load the
‘Defaulted” CAD package as well as In-Survey

2 Separate Programs are running!!

e 70 DWs, Wel F2000 DW, Resd O] Wi Vi
e £8 Epmmt o Lok Liser oo Mt

e T e P J e e - R e 1|

@ Ele Edt Yew Iet Fomat ook Diaw Dimepsion Modiy Window Help
DEESL@ s bBS 0 i QQQM x,
;

FEie Suface Geomety Evalustion Modeker Jooks Hebp
e 180116 N % 5¢ X [
SileceNane | Descrpton

@ 0eot
@ iy
Moo Clostdsy Rosduey Hodste
= binder Crested By Roadway Modeler
[ b Crteds Rona Hoddr
I TATas] | @ sboste  Cesodby RosduayMocelr

| SR I | e

Toagles Locate Featres/Locae Graphics mode

SEBE SR

PEE- 880200008

SYNCL+spae

[EREIDACIL M ode!

Ae=2uxD
—_— s LT
[T Conier Dpamic Bvonte Proviou see e Anden] cveal © L
[Press ESC o gt play shori g

26505, 6.15.05, 000,00 SNAP. GRID| ORTHO] POLAR] DSNAP DTRACK, LT [WODEL.
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InRoads Survey handles oy ey

<Umane = | G N\ % 3¢ X

Sutace Name | Deseiption
Crested By Rosday Modeler
Clested By Roscay Modeler

the ‘Engineering’ Rl il
=]
C AD S the viewer Stints [ O R TR o] | simose  Costdsy Rosdmaiodon

Taggies Locae Featres/Lacals Graghice mode

T e T (Zilz]
o ae e P Toe T DoagnHidy oo o il

DE@EL® &%EG\““H‘EFﬁEQM Lgentqa® B ? +
|2 & Femwar [Gee= B J—eae [ ]

S e P e ) et e
BiiEs ro

5 rerm pren
ot o ioht ol vo Biehies Shonitas aemn - [ 1= FTOCET
[2.85E 105, £ 156405, 00CE 400 SHAP GRID DRTHD FOLAR DSNAP| DTRACK LW [MODEL Sy aesiés:
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Viewing Fieldbook Data

The Survey > View :

Survey Data from the RS FCEYIITLL
Main Menu & the View.
Survey Data toolbar
allows the display of
the field book data

These views are
‘temporary’ graphics
and can be toggled on
& Off

© 2011 Zen Engineering|

Viewing Fieldbook Data (symbology)

Sym bol ogy. for some of [ enerel| Units | Symbokogy | Coections | Dbservation

~Survey Symbology

these graphics are under [ s

Elevation Frecision: [ 72

Tools > Survey Options I ——
The Text Symbology Tab
defines the Symbols,
Codes, Notes, Points,
Elevations and Errors.

ata

x|
EHLLERARDY BEEB

© 2011 Zen Engineering
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Viewing Fieldbook Data (text sizes)

¢ Text has a View’ size
for the temporary display [ —
under “Edit View...’ pe e - -

C The text size set under LT ro—
‘Edit..." determine the
setting when the Survey
IS committed to graphics

C MicroStation text size Is
view independent” ___ -
and will remain this  [emmm—

Size iIndependent of RESENT ol |

Z0oming in or out. Lne Spacing [500 el
(SOI’I’y AgAD USGI'S) Harizontal Offset: Iggg— 4')'

Yertical Offset: 0.00

General| Unts  Sumbology | Conections | Observation Standard Deviation |

© 2011 Zen Engineering|

Viewing Fieldbook Data (pianimetrics)

C The General tab e —
Settings deal With: Chord Height: [pom

Point Seed:

Eigure Seed.

Global Scale factors S
tied into the display TeiSest WD st T e e

Line Scale: [i-o00 [

- File Optian

Settings related to 7 BeoheCode En I~ SoveCompued oot
3 ¥ Laog Cade Errars ™ Add/Edit udit Trsil
Error checking

Varlous plan dISpIay ~ Planimetic Setting
of the Fieldbook data [ Uieluon Dpeins 7 e Do o

W Use Symbols [ Attach Attribute Tags
W Use Celly

Wigw Dption:
[W Automatic Refresh ™ Segregate Text by Feature Level

I™ Include Custom Operations, Symbols and Call in Single Call

Save bs

© 2011 Zen Engineering
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Coding - Who is ...7?

ool Sury Coding s
Edi Mew lnset Fomal ook Dala Window Help

Slpru =EEEAsal -2-A- 7

Titats AT @ | 2 o | v Ropk vinChanges  EpdFievion..

B -

T L E Show of hands:

Who has a
Standardfield
coding list?

Who uses their,
fieldicoding
Standards?.

© 2011 Zen Engineering|

Coding Is the Key!!

Coding is how In-Survey interprets the

collected data
Good coding
makes the
Interpretation
more accurate

Lack of, or poor
coding makes it
more difficult

© 2011 Zen Engineering
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The Brains of In-Survey

% Style Manag =[olx]

- Shaw Styles with Prop: Surface Props: Geomety Tebifg: Close
I~ Include Sutace = iscleylen = Rt Tabiig

N
[he Style Vianager. I et || bigonsesin| | I 1oty | 2% |
™ Include Geometry Line I Dipfap Prafil= = A Tt L‘

d efl n eS h OW th e fl e I d I™ Includs Geometry Arc = Faylien I piral Teting, Lol
™ Include Geomety Spiral Copy Settings

H 1 I ¥ Include Suvey Eu'éiysl'z:pﬂap"::huns I Attibutes Delete
odaing IS Interprete

For CAD Display Pt i s e ]

Name [ Descrption [ Aipha Code [ Mumeic Code [ Paps]
. fw/LKBC BITUMINOUS WALK [ 108 -
For Surface creation e ounere v
STEPC CONC STEPS

STEPw  wOOD STEPS
FRERK, FR TRACKS [RAIL LOCATED)
For Geometry CHAIN LINKAWIRE FENCE

CHAIN LINKAWIRE FENCE
PICKET/RUSTIC FENCE
PFICKET/RUSTIC FENCE
FIFE RAIL FENCE
BOARD FENCE
EDGE OF WATER [PONDALAKE]
STREAM &/0R ‘WATER COURSE
PAUED DITEU
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Survey Field Codes

tyle Manager 9 =1 E
- Shew Styles with Props Suiface Fio Geomeiy Tabing,
e i ach shot collecte
™ Include Geometry Point IS Oisaiensss Gestion| M S e ting)

™ Include Geomety Line 1= | Disslzy Prafife I= | 1 Tietiing I n th e fle I d IS

T Include Geomety Arc = Byt I Spial Tebig,

T Include Geometry Soial d b
I ey representea by an

item in this manager
Preference File: C\Ztiain\SurvSect!szenl. xin

T 5 The table defines

CONCRETE WALK.

CONC STEPS

WP e the characteristics

CHAIN LINKAWIRE FENCE

CHAIN LINKAWIRE FENCE . .

PICKE T/RUSTIC FENCE

PICKET/RUSTIC FENCE f h f I d t
R or eacn lieid 1iem
BOARD FENCE

EDGE OF WATER (POND /LAKE]

STREAM &/OR WATER COURSE
BAET NIT PR

) 2011 Zen Engint
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Drafting - Who'is ...?

£ con_ e e 330 BGN) Wit V3 2004 ke

., Show of
hands:

Who takes
the field
data and
‘draws’
the survey,
manually?

© 2011 Zen Engineering|

<, CAD is used
as a viewing
mechanism
for InRoads
Survey

 The CAD file
isn’t part of
the survey
database

[ -M-08~% GELEE[DeGS Ib8 -~ @ 7]
Tt

© 2011 Zen Engineering
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Viewing Fieldbook Data

LR ARDDZ ASER
=

< View:
Plan drawing
Shot locations
Point Number
Point Coding
Elevation
Notes
Error Messages
[raverses

euBCATpOLE (Mal:cF B~
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Correction ‘Phase 2’

¢ The Fieldbook is ‘Cleaned Up’ in two distinct
phases:

Plan View — Planimetric ‘visual’ line work and
graphics ... the Drafting / Drawing

3D — Elevational corrections via the DTM
C The Elevational Aspect clean-up is next...
IE 3D is required by the scope of the project

© 2011 Zen Engineering
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Surfaces - Who is ...~

Show of hands:

Whoe has to View
contours ofithelr
Survey?

Whoerhas te build
3D Surface
moedels ofi thelr,
Survey data?

© 2011 Zen Engineering|

Surface Basics

Survey can create a Digital Terrain Model (.dtm)
from the collected field data

The surfaces that are created can be used in
InRoads, InRail, Site, Storm & Sanitary. ... etc.

There are different point Types that Survey can
use to build the 3D Model

Point locations, Breaklines, closed shapes, Excluded...
Each point Type relates to the kind of data that is

collected in the field and how that data should be
Incorporated into the surface model!

© 2011 Zen Eng ing
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Creating a Surface Model - DTV

C The Surnvey Data to
Surface command
creates a DTM based

on the field data
Then use any.
Surface commands
on the main menu

< The DTM is based on
the field Coding

<, Show of hands:

\Whorhas te display the
JEOMELNICS Of thelr SUrvey
data?

Who has te input Iraversing,
'egal Descriptions; Control
RPoints o contreliines in
additionitorthe datarcollected
INthetield?

© 2011 Zen Engineering
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Creating a Geometry File - ALG

C The Surnvey Data to
Geometry. command
creates geometry
based on the field

collected data
Then use any.
Geometry. commands
on the main menu

¢ Every shot can be
pushed into the ALG

© 2011 Zen Engineering|

e Survey Data to Geometry fi\

Project Mame: |Ex|snng "l [

Use Sty Desciption | [ Cioes |
Curg Stwoking:  [Hozontal Orlp v
Harizontal Only b

Duplicate Names: () Replace

Description:

] Empty Project
Build Extended Description
Irsert:

Abtribute Name

Estended Description:

Write the Drawing to CAD

C Survey > View
Survey Data >
\Write Survey Data
1o Graphics saves
your viewable data
to the CAD file

¢ The Fieldbook
viewing Is
temporary until this
step is done

© 2011 Zen Engineering

&

= Write Survey Data to Gra... E]|:|E]

1<

ERs
=
g

ooooog
Kl
zzmm
rgas
£é
2

[ Planarize

Curve Stroking Mode! | Horizontal Gl -

;[qh‘
j -
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Saving a Survey Fieldbook - .fwd

The File > Save As command allows you to
create an F\WD that contains all the field book
data ¥ Save As 7] x]

The .fwd file can be i B L 18l =
Open into later Survey  |mies

sessions and all the

changes & data will be _

present gy i

© 2011 Zen Engineering|

Key InRoads Survey File Types

XIN'—= Configuration file
Survey Coding list
CAD presentation controels
Units, prism corrections & other info about the survey

.FWD — Survey project file
Coordinates, Station & Observation data

.DTM — 3D Surface model created from the
collected fieldbook data

ALG — Geometry Project created from the
collected fieldbook data

.DGNer.DW.GE— CAD graphics file

© 2011 Zen Engineering
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Basic Workflow

Collect the field data and export an ASCI| file
ASCI| files are imported and processed by In-Survey

Import the ASCI| field data into InRoads Survey.
This creates an InRoads Survey Fieldbook

Edit / Correct / Add //Adjust the data
The InRoads Survey Fieldbook contains the final work

Display the CAD Graphics with InRoads Survey
Create the Surface Moedeliwith InRoeads Sur/ey.
Create any. Geemetny/with InReads Surey.

© 2011 Zen Engineering|

In-Survey Historical Note

Field¥orks 2.0 - FieldWorks 2.0
File Setings Wiow [N Help File_Settings Lifgg] Utilitics Help
Fieldbook.. . = [0 Plnmlcllu.'-s
Generate Surface. o PDILI.S_
Transform. __ O Elevations

- . O Codes
Commit Drawing to DGN ___ O Contours

O Iraverse

O Ficld Notes

In-Survey used to be “Field\Works” O Code Erors

Eit
Palette

FieldWorks had very basic tools
...and sometimes too basic

© 2011 Zen Engineering
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InRoads Survey Now

i Bentley InRoads Survey XM Edition

File Sufsce Geomety Suvey Evslustion Drafiing Tock Help

|
[ Station Mame [ Mertking | Essting [ Etewatior, [ Cote [ Backsighr . | Backsight Dirsct [ =]
JATOLEHS  70I14BE4E8 5960076 3225.. 53 205"
EE ligrment Project JATOLEHE  7OII4BE4ER GIEO0TE  3226..
-] Temporary Testing Fisldbook 3733590083 70362630 542840 3225 53 124m84”
3745041170 7092622210 6458240 CP 56 180°5923"

25 Sufaces | 2 Geomely | P Preferences & swer | | 374967.9777 7065112302 5379006 3225.. 49 1|52~19-44-‘ ;';|
v

FieldWorks has evolved to include key ‘InRoads’
functionality useful to a Survey department

This software evolution resulted in InRoads
Survey.

© 2011 Zen Engineering|

InRoads Locks

"™ SelectCAD

File Suface Geomety Evaluation Model

Turn On/Off the locks toolbar

In-Survey > Tools > Locks = ko
These controls regulate the T

fbl Convert Pencil toInk

output, Input or processing of |jses

b Flun Macro

certain In-Survey commands — [eissesmm
These Locks apply primarily. ===
to the exported data

x|
<Unnamed:> B N | B |5”-55'

[v Toohar

© 2011 Zen Engineering

Page 18



Basic Workflow - Summary

Many. types of data collectors ASCII Files can be loaded

ASCII files imported into Survey are not processed until
all the files have been read into memory.

Errors in the data can be corrected as the files are being
processed or later in the Fieldbook

Graphics that Survey produces from the on-line
Fieldbook are ‘temporary’ and are not written to a design
file until using the Write Survey Data... command.

Data added to a digital terrain model is controlled by the
DTWM feature associated with a particular field code

The Geometry can be saved from the collected field data

© 2011 Zen Engineering|

Lab 1.4 - Overview

Establishing the Project Default settings
Import a field collected file

View the imported data

Getting familiar with the In-Survey fieldbook
Taking a first look at the Style Manager
Exporting a digital terrain model (surface)
Exporting a Geometry data file

Saving all the created data

...Get stanted on page 49

© 2011 Zen Engineering
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